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Overview 

Stellar Phoenix Outlook PST Repair offers a complete solution to repair damaged Microsoft Outlook 
Personal Storage (PST) files. 

The software repairs corrupt PST files and restores all its content such as e-mails, attachments, contacts, 
calendars, tasks and journals. Stellar Phoenix Outlook PST Repair scans and extracts data from a 
damaged PST file, repairs it and then saves it as a new usable PST file. To view repaired items, you need 
to import the new PST file into MS Outlook. 

Stellar Phoenix Outlook PST Repair also ensures recovery of accidentally deleted e-mails that you 
have emptied from the deleted items folder. After recovering the PST file, the software shows its original 
content. All folders from the original PST file are shown along with their content in a three-pane structure.  

What's New in this Version? 

 Support for MS Office 2016. 

 Support to transfer the license of the registered software to another computer 

Key features: 

 Enables you to view messages in a 3-view format. 

 Selective recovery of mails. 

 Find option to search mails faster. 

 Repairs e-mails, calendar entries, contacts, notes, tasks and journals from damaged PST files. 

 Restores formatting from RTF and HTML messages. 

 Repairs encrypted PST files. 

 Repairs PST files larger than 2GB. 

 Repaired file is saved as new PST file on any (including network) disk visible by the host 
operating system. 

 Can save single mail messages in EML, MSG, RTF, HTML, and PDF format. Creates unique 
profile for individual PST files. 

 Enhanced preview feature for calendars, tasks, journals, and contacts. 

 Support for MS Office 2013 / 2010 / 2007 / 2003. 

 New GUI - look and feel matches MS Office 2007 / 2010 / 2013 GUI 



Installation Procedure 

Before installing the software, ensure that your system meets the minimum system requirements. 

Minimum System Requirements 

 Processor: Pentium Class 

 Operating System: Windows 10 / Windows 8 / Windows 7 / Windows Vista 

 Memory: 512 MB 

 Hard Disk: 50 MB of free space 

 MS Outlook: 2016 / 2013 / 2010 / 2007 / 2003 / 2002 (XP) / 2000 

 Internet Explorer: Version 6.0 or later 

To install the software: 

1. Double-click StellarPhoenixOutlookPSTRepair.exe executable file to start installation. Setup - 
Stellar Phoenix Outlook PST Repair dialog box is displayed. 

2. Click Next. License Agreement dialog box is displayed. 

3. Choose I accept the agreement option. Next button will be enabled. Click Next. Select 
Destination Location dialog box is displayed. 

4. Click Browse to select the destination path where the setup files will be stored. Click Next. 
Select Start Menu Folder dialog box is displayed. 

5. Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks 
dialog box is displayed. 

6. Select check boxes as per your choice. Click Next. Ready to Install dialog box is displayed. 

7. Review your selections. Click Back if you want to change them. Click Install to start installation. 
The Installing window shows the installation process. 

8. On completion of the installation process, Completing the Stellar Phoenix Outlook PST Repair 
Setup Wizard window is displayed. Click Finish. 

Note: Clear Launch Stellar Phoenix Outlook PST Repair check box to prevent the software from 
launching automatically.  



Launching the Software 

To launch Stellar Phoenix Outlook PST Repair in Windows 10: 

 Click Start icon -> All apps -> Stellar Phoenix Outlook PST Repair -> Stellar Phoenix Outlook 

PST Repair . Or, 

 Double click Stellar Phoenix Outlook PST Repair icon on the desktop. Or, 

 Click Stellar Phoenix Outlook PST Repair tile on the home screen. 

 

To launch Stellar Phoenix Outlook PST Repair in Windows 8.1 / 8: 

 Click Stellar Phoenix Outlook PST Repair tile on the home screen. Or,  

 Double click Stellar Phoenix Outlook PST Repair icon on the desktop. 

 

To launch Stellar Phoenix Outlook PST Repair in Windows 7 / Vista / XP: 

 Click Start -> Programs -> Stellar Phoenix Outlook PST Repair -> Stellar Phoenix Outlook PST 

Repair. Or, 

 Double click Stellar Phoenix Outlook PST Repair icon on the desktop. Or, 

 Click Stellar Phoenix Outlook PST Repair icon in Quick Launch. 



User Interface 

Stellar Phoenix Outlook PST Repair has a simple and easy to use Graphical User Interface (GUI). The 
GUI of  Stellar Phoenix Outlook PST Repair resembles the GUI of MS Office 2007.   

After launching the software, the main user interface appears as shown below:  

 

The user interface contains menus and buttons that allow you access various features of the software 

with ease. 

When you start Stellar Phoenix Outlook PST Repair, the Select Outlook Mailbox dialog box opens as 

shown below: 

 

To select a PST file, click on Select Outlook File button. Select the PST file that needs to be repaired 
and then click Start to start the repairing process.  



Stellar Phoenix Outlook PST Repair also allows you to search for PST files, in case you don't know the 
location of the PST files to be repaired. Click on Find Outlook File button, Find Mailbox dialog box 
opens. Use Look in to specify the drive in which you wish to search for PST files, and then click Start to 
search for files.  

Note: Select Outlook Mailbox dialog box can also be opened by selecting Select Outlook Mailbox in 

the File menu. 



Menus 

File 

Select Outlook Mailbox 

Opens Select Outlook Mailbox dialog 
box, using which you can select / search 
for PST files. 

Save Repaired File 

Saves the repaired PST file at your 
specified location. 

Find Message 

Use this option to search for specific 
emails and messages from the list of the 
scanned emails. 

 

 

 

 

File Menu 

 

View 

Switch Reading Pane 

Use this option to switch between 
horizontal and vertical views of the reading 
pane. 

Log Report 

Use this option to view the log report. 

 

 

View Menu 

 

Tools 

Update Wizard 

Use this option update your software 

  

Tools Menu 

 



Calendar 

Day 

Use this option to list all the entries of a 
particular day from the list of the scanned 
emails. 

Work Week 

Use this option to list all the entries of a 
work week (from Monday to Friday). 

Week 

Use this option to list all the entries of a 
week (from Monday to Sunday). 

Month 

Use this option to list all the entries of a 
particular month. 

GoTo 

Use this option to list all the entries of the 
current date or any particular date.  

 

 

 

Calendar Menu 

 

Registration 

Register 

Use this option to register the software 
after purchasing the software.  

Transfer License 

Use this option to transfer the license of 
the registered software to another 
computer. 

 

Registration Menu 

 

Help 

Help Topics 

 

 



Use this option to open the help manual of 
the software. 

Order 

Use this option to buy Stellar Phoenix 
Outlook PST Repair.  

Support 

Use this option to visit the support page of 
stellarinfo.com 

Knowledge Base 

Use this option to visit the Knowledge 
Base articles of stellarinfo.com 

Enquiry 

Use this option to submit enquiry to 
stellarinfo.com 

About 

Use this option to read information about 
the software.  

 

 

 

Help Menu 

 

Style 

Use this option to switch between various 
themes for the software, as per your choice. 
Stellar Phoenix Outlook PST Repair offers the 
following themes: Office 2007 (Blue, Black, 
Silver, Aqua), Office 2010 (Blue, Black, 
Silver), and Office 2013 Theme. 

 

Style Menu 

http://www.stellarinfo.com/index.php?route=product/buynow&product_id=62
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/enquiry.php
http://www.stellarinfo.com/


Buttons 

Stellar Phoenix Outlook PST Repair toolbar has following buttons / options: 

 

 

Click this button to open Select Outlook Data File dialog box. 

 

 

Click this button to save the repaired PST file to a location of your choice. 

 

Click this button to switch between horizontal and vertical views of the reading 
pane. When you click on a folder in left-pane, by default, the right pane shows the 
details in horizontal columns position. You can click Switch Reading Pane icon to 
change the position to vertical columns. 

 

 

Click this button to view the log report, which contains the details of the repairing 
process. 

 

 

Click this button to open Find Message dialog box, using which you can search for 
specific emails using sender's email, recipient's email, subject, or date.  

 

 

Click this button to update your software. Use this option to check for both, major 
and minor versions of the software.  

 

 

Click this button to list all the entries of one particular day from the list of the 
scanned emails. 

 



 

 

Click this button to list all the entries of a work week (from Monday to Friday). 

 

 

Click this button to list all the entries of a week (from Monday to Sunday). 

 

 

Click this button to list all the entries of a particular month. 

 

 

Click this button to list all the entries of the current date. 

 

 

Click this button to list all the entries of a particular day (any single day except the 
current date). 

 

 

Click this button to register the software after purchasing.  

 

 

Click this button to transfer the license of the registered software to another 
computer. 



 

 

Click this button to open the help manual for Stellar Phoenix Outlook PST Repair. 

 

 

Click this button to purchase the software. 

 

 

Click this button to open Stellar Information Technology Private Limited online 
support website. 

 

 

Click this button to visit the Knowledge Base articles of stellarinfo.com 

 

 

Click this button to submit an enquiry to stellarinfo.com 

 

 

Click this button to read more information about the software. 

 

  

  

  

  

 



Ordering the Software 

To know more about Stellar Phoenix Outlook PST Repair, click here. 

To purchase the software online, please visit http://www.stellarinfo.com/email-repair/outlook-pst-
repair/buy-now.php 

Alternatively, click on Order icon in Help Menu on Menu Bar to purchase the software online. 

Select either of the methods given above to purchase the software. 

Once the order is confirmed, a serial number will be sent to you through e-mail, which would be required 

to activate the software. 

http://www.stellarinfo.com/outlook-pst-file-recovery.php
http://www.stellarinfo.com/email-repair/outlook-pst-repair/buy-now.php
http://www.stellarinfo.com/email-repair/outlook-pst-repair/buy-now.php


Registering the Software 
The demo version is just for evaluation purpose and must be eventually registered to use the full 

functionality of the software. The software can be registered using the Registration Key which you will 

receive via email after purchasing the software.  

To register the software: 

1. Run demo version of Stellar Phoenix Outlook PST Repair software. 

2. On Tools menu, click Register option. Register window is displayed as shown below. 

 

3. Choose ’I don’t have the registration key’ (Use this option if you have not purchased the 

product) or select ’I have the registration key’ (Use this option if you have already purchased 

the product). 

To register the software, when you do not have a registration key, follow the steps given below: 

1. In the Register window, select 'I don't have the registration key' option. Click OK, to go online 

and purchase the product. 

2. Once the order is confirmed, a Registration Key will be sent to the email provided at the time of 

purchase.  

3. In the Register window, type the Registration Key and click Register button (Please ensure 

that you have an active Internet connection). 



 

4. ' Activation Completed Successfully ' message is displayed after the process is completed 

successfully. Click OK.  

To register the software, when you have a key, follow the steps given below: 

1. In the Register window, select 'I have the registration key' option. 

2. You can choose either 'Online Registration' (Use this option to register the software over 

Internet) or 'Offline Registration' (Use this option to register the software manually / through e-

mail if for any reason, Internet connection is unavailable). 

 Online Registration 

Online Registration is possible only when an active Internet connection is available. 

o To register the software online: 

1. From the Register window, select Online Registration. Click OK.  

 



 

 

2. An Online Registration dialog box will appear. 

3. Type the Registration Key (received through email after purchasing the product) in the 

field of Registration Key. Click Register. 

 

4. The software would automatically communicate with the license server to verify the entered 

key. If the key you entered is valid, software will be registered successfully. 

 Offline Registration 

Offline Registration enables you to register the product when your computer does not have an Internet 

connection. 

o To register the software offline: 

1. From the Register window, select Offline Registration. Click OK.  

 



2. An Offline Registration dialog box will appear displaying Registration ID in its respective 

field. 

 

3. To get your License Key, which is required to register the software manually, you need to 

mail the listed Registration ID to support@stellarinfo.com. 

4. A License Key will be sent to your email address after verifying the Registration ID and 

purchase details by Stellar Technical Support. 

5. After receiving the License Key, open Stellar Phoenix Outlook PST Repair. In Register 

window, select 'I have the registration key'. 

6. Select Offline Registration and click OK. 

7. Enter the License Key received through email in the field of License Key.  

 

8. Click Register to activate the software. A confirmation message is displayed if a valid key is 

entered. Click OK. 

mailto:support@stellarinfo.com


Transfer License 
Stellar Phoenix Outlook PST Repair allows you to transfer the license of the registered software to 

another computer on which you want to run the software with full functionality. This operation deactivates 

the product on your current computer so it can be reactivated on the new computer.  

To transfer a software license from one computer to another, please follow the specific steps 
below: 

On Target Computer:  

1. Run demo version of the software. 

2. In Tools Menu on Menu Bar, click Register. A new dialog appears. 

3. From the Register window, select Offline Registration. Click OK.   

4. An Offline Registration dialog box will appear displaying Registration ID in its respective 

field. 

 

 

On Source Computer: 

1. Run registered version of Stellar Phoenix Outlook PST Repair software. 

2. In Tools Menu on Menu Bar, click Transfer License. 



 

3. Copy the Registration ID displayed on the Target Computer in the field of Registration ID on 

the Source Computer. 

4. To get your License Key, click Transfer In button on Source Computer. This will generate a 

License Key. 

 

5. You can also save the License Key generated on the source computer. Click Save to File 

button to save the Registration ID and the License Key. In Browse for Folder dialog box, 

select the location where you want to save the details. Click OK. 

6. ' License Key has been saved successfully ' message is displayed after the saving process is 

completed successfully. Click OK. 

This will deactivate the product on Source Computer and you will no longer be able to use the software 

anymore on this computer. 

 

On Target Computer: 



1. Type the License Key which you have generated on the Source Computer in the provided field 

of License Key. 

 

2. Click Register to complete the activation process.  

3. ' Activation Completed Successfully ' message is displayed after the process is completed 

successfully. Click OK. 



Updating the Software 

Stellar releases periodical software updates for Stellar Phoenix Outlook PST Repair software. You can 
update the software to keep it up-to-date. These updates can add a new functionality, feature, service, or 
any other information that can improve the software. Update option of the application is capable of 
checking for latest updates. This will check for both latest minor and major versions available online. You 
can easily download minor version through the update wizard. However, the major version, if available, 
has to be purchased. While updating the software, it’s recommended to close all the running programs. 
Note that demo version of the software cannot be updated.  

To update Stellar Phoenix Outlook PST Repair: 

1. Go to Tools option in Menu Bar. Click Update Wizard.  

2. Stellar Phoenix Update Wizard window will open. Click Next. The wizard will search for latest 
updates, and if it finds any new updates, a window will pop up indicating its availability. 

3. Click Next and the software will download the files from the update server. When the process is 
complete, the software will upgrade to the latest version. 

Live Update may not happen due to following reasons: 

 Internet connection failure 

 Updates are not available 

 Unable to download configuration files 

 Unable to locate updated files or version 

 Unable to locate executable file 

Note:  If a major version is available, you need to purchase the software in order to upgrade it.  



Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar products. 

You can either call us or go online to our support section at http://stellarinfo.com/support/ 

For price details and to place the order, click http://www.stellarinfo.com/email-repair/outlook-pst-

repair/buy-now.php 

Chat Live with an Online technician at http://www.stellarinfo.com/ 

Search in our extensive Knowledge Base at http://www.stellarinfo.com/support/kb 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php 

Send e-mail to Stellar Support at support@stellarinfo.com 

 

Support Helpline 

Monday to Friday [ 24 Hours a day ] 

USA (Toll 

free Pre 

Sales 

Queries) 

+1-877-778-6087 

USA (Post 

Sales 

Queries) 

+1-732-584-2700 

UK 

(Europe) 
+44-203-026-5337 

Australia & 

Asia Pacific 
+61-280-149-899 

Netherlands 

Pre & Post 

Sales 

+31-208-111-188 

http://www.stellarinfo.com/support/
http://www.stellarinfo.com/email-repair/outlook-pst-repair/buy-now.php
http://www.stellarinfo.com/email-repair/outlook-pst-repair/buy-now.php
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/support/enquiry.php
mailto:support@stellarinfo.com?


Support 

Worldwide +91-124-432-6777 

Email Orders    orders@stellarinfo.com 

 

mailto:orders@stellarinfo.com?subject=Purchase%20Order

